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CONHECIMENTO DO ESPAÇO GEOGRÁFICO A PARTIR DO GEOPROCESSAMENTO 

 

Em virtude dos avanços conceituais e práticos proporcionados pelas geotecnologias nos mais 
diversos estudos que envolvem o meio ambiente geográfico, torna-se de suma importância o uso 
das técnicas e ferramentas de geoprocessamento na contemporaneidade, buscando a 
compreensão das inter-relações que se materializam no espaço geográfico com vistas à análise, 
comparação e cruzamento de informações obtidas por meio de dados e mapas digitais 
(ALBUQUERQUE, 2012). 

Destaca-se que o conceito de geoprocessamento pode ser descrito como um conjunto de 
técnicas matemáticas e ferramentas computacionais capazes de operar sobre uma informação ou 
dado que tenha expressão espacial. É definido por Xavier-da-Silva (2001) como uma tecnologia 
computacional integrada que opera sobre bases de dados, ou seja, possui capacidade para 
integrar os elementos georreferenciados e transformá-los em informação, que é o acréscimo de 
conhecimento ao dado bruto com uma determinada finalidade. 

De acordo com o INPE (2000), citado por Cunha (2001), o geoprocessamento é um conjunto de 
tecnologias voltadas à coleta e tratamento de informações espaciais para um objetivo específico. 
Eles são destinados ao processamento de dados georreferenciados desde a sua coleta até a 
geração de produtos como mapas, relatórios e arquivos digitais, oferecendo recursos para 
armazenamento, gerenciamento, manipulação e análise de dados. 

Em virtude de sua aplicabilidade, o geoprocessamento, conforme Gomes (2010) é uma 
importante ferramenta de gestão territorial, pois a mesma possibilita uma melhor análise visual e 
numérica nas modificações da paisagem, integrando em um único banco de dados informações 
numéricas e espaciais. Esse processo viabiliza o cruzamento e a sobreposição dessas 
informações que são determinantes para o entendimento da evolução espacial e temporal dos 
diferentes fenômenos ocorridos na área que se pretende trabalhar.  

Vale frisar que o termo geoprocessamento não possui um conceito único, em virtude de ser uma 
área bastante abrangente sobre o ponto de vista de suas aplicações. Pode ser descrito, em 
suma, como sendo um conjunto de técnicas matemáticas e computacionais relacionadas ao 
manuseio (coleta, armazenamento, tratamento e análise) da informação espacial, ou seja, 
representada pelo processamento de dados e/ou informações que tenham expressão espacial.  

Nessa perspectiva, o geoprocessamento apresenta-se como uma ferramenta que se mostra 
exitosa no desenvolvimento de ações que visam melhorar e adequar a gestão das análises 
sociais e ambientais, como também no desenvolvimento científico para o conhecimento da 
realidade, mesmo diante das mais diversas complexidades, tornando-se imprescindível para o 
ordenamento territorial.  

Destaca-se como forma de coleta de dado no geoprocessamento o sensoriamento remoto, que é 
uma ciência que permite obter imagens e outros tipos de dados, da superfície terrestre, por meio 
da captação e do registro da energia refletida ou emitida pela superfície (FLORENZANO, 2007), 
possibilitando a extração de um leque de informações que possam subsidiar o ordenamento 
territorial e delinear uma melhor gestão do território. 

Em consonância com o conceito mencionado, Jensen (2009) define que o sensoriamento remoto 
é a arte e a ciência de obter informações de um objeto sem estar em contato físico com ele, 
podendo ser usado para medir e monitorar importantes características biofísicas e atividades 
humanas na Terra. Desta forma, o sensoriamento remoto utiliza a radiação eletromagnética 
refletida e emitida por sua superfície para registrar essas características. 
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Vale salientar que uma imagem é subdividida em pixels, os quais são uma área mínima na 
superfície imageada pelo sensor com localização espacial definida, para a qual foram registrados 
os valores digitais referentes à intensidade de energia refletida em diferentes faixas do espectro 
eletromagnético (NOVO, 1992). 

Na tentativa de melhorar os dados captados pelos sensores remotos, é de significativa 
importância o uso do Processamento Digital de Imagens – PDI, que é uma ferramenta 
fundamental no geoprocessamento, pois a partir da mesma é possível melhorar o aspecto visual 
de certas feições estruturais para o analista humano e para fornecer outros subsídios para a sua 
interpretação, inclusive gerando produtos que possam ser posteriormente submetidos a outros 
processamentos (MEDEIROS, 2004).  

Nesse mesmo contexto e, em virtude de sua aplicabilidade, o geoprocessamento é uma 
importante ferramenta cartográfica que possibilita melhor análise visual e numérica nas 
modificações da paisagem, integrando em um único banco de dados informações numéricas e 
espaciais provenientes das mais diversas fontes, processo esse atrelado ao Sistema de 
Informação Geográfica - SIG.  

Na perspectiva de dar uma roupagem conceitual aos SIGs ou Geographic Information System – 
GIS, seu equivalente em inglês, torna-se necessário abordar alguns conceitos chave que 
norteiam as suas principais características quanto às suas finalidades de aplicação e, 
consequentemente, como viés delineador das questões concernentes ao espaço geográfico, com 
vista à análise, a comparação e o cruzamento de diferentes dados. 

Para Câmara et al. (1996), é possível indicar entre as principais características do SIGs a 
capacidade de inserir e integrar, em uma única base de dados, informações espaciais 
provenientes de dados cartográficos, censitário e cadastro urbano e rural, imagens de satélites, 
redes e modelos numéricos do terreno, oferecendo mecanismos para combinar as várias 
informações através de algoritmos de manipulação e análise, bem como para consultar, 
recuperar, visualizar e plotar conteúdo da base de dados georreferenciada.  

Numa visão abrangente, pode-se indicar que um SIG tem os seguintes componentes: interface 
com usuário; entrada e integração de dados; funções de consulta e análise espacial; visualização 
e plotagem; armazenamento e recuperação de dados, organizados sob a forma de um banco de 
dados geográficos (CÂMARA et al., 1996). 

Conforme Land e Blaschke (2009), os SIGs fornecem valiosas contribuições no apoio às tarefas e 
aos projetos de planejamento e ordenamento territorial, que a cada dia tornam-se mais 
complexos e robustos diante dos avanços tecnológicos, tendo em vista que essa ferramenta 
proporciona a otimização das informações por meio de consultas espaciais e tabulares. 

Dessa forma, todos os conceitos abordados neste tópico, quando tratados sob o ponto de vista 
dos seus inter-relacionamentos, possibilitam uma visão integrada e constituem fontes de 
informações fundamentais para a compreensão integrada do espaço geográfico, pois a 
necessidade de percepção do conjunto é um requisito essencial na análise do ambiente e na 
concepção do meio geográfico. 
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TÉCNICAS DE GEOPROCESSAMENTO COM O PROGRAMA ARCGIS 

 
Esse Turorial foi elaborado como uma forma de promover uma melhor compreensão dos alunos 
que participam, participaram ou participarão dos Cursos de Extensão promovido pelo Laboratório 
de Geografia e Estudos Ambientais (GEOAMBIENTE) e do Grupo de Estudos em 
Geotecnologias: Pesquisa e Ensino (CNPq/UFPI), vinculado à Coordenação do Curso de 
Geografia (CGEO), do Centro de Ciências Humanas e Letras (CCHL), da Universidade Federal 
do Piauí (UFPI), Campus Petronio Portela, Teresina-PI, tendo como objetivo promover a 
produção de mapas por meio de ferramentas que auxiliam na espacilaização dos dados e 
informações geograficas, usando os softwares ArcGIS na sua versão 10.5 e o Qgis na versão 
2.14.  
 
 

 

GEOPROCESSAMENTO APLICADO À ANALISE GEOGRÁFICA COM O ARCGIS 

 

 Abrir novo projeto 
Organizar a plataforma do ArcGIS com os arquivos contendo os dados em uma pasta do 
computador (Local C), de forma bem organizada, para que a inserção seja de facil compreensão; 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
As pastas devem conter o nome e os dados de forma bem direcionadas, não contendo caracteres 
que possam causar problemas ao programa como (espaço entre os nomes, ponto, virgulas e 
acentuação), essa organização abaixo é apenas uma forma de orgazinar o direcionamento do 
programa; 
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Clicar no Arctolbox e adcione algumas ferramentas que serão uteis ao longo do projeto. 
Barra de ferrametas habilitar: Customize _ 3d analist _ ajusts spacial _ desenhar _ Edit_ 
Ferramentas _ Georreferencing _ GPS _ layout_; 
 

 
 
Para a produção do mapa será repassado uma pasta (entrar em contato com os autores) que 
acompanha o material onde contem dados tanto vetoriais, alfanumericos como matriciais, contudo 
há varios sites que disponibilizam gratuitamente vários dados. Onde encontrar os dados 
Matriciais? Mas primeiro você precisa compreender o que são esses dados 
matriciais??https://www.lapig.iesa.ufg.br/lapig/cursos_online/qgis/dados_matriciais.html 
conheca algumas propriedade desse satelite http://www.engesat.com.br/imagem-de-
satelite/landsat-8/ 
A aquisição pode se feita nos seguintes portais: https://earthexplorer.usgs.gov; 
http://geocatalogo.mma.gov.br/; https://earthengine.google.com/; http://www.dgi.inpe.br/CDSR/ e 
vários outros.  

https://www.lapig.iesa.ufg.br/lapig/cursos_online/qgis/dados_matriciais.html
http://www.engesat.com.br/imagem-de-satelite/landsat-8/
http://www.engesat.com.br/imagem-de-satelite/landsat-8/
https://earthexplorer.usgs.gov/
http://geocatalogo.mma.gov.br/
https://earthengine.google.com/
http://www.dgi.inpe.br/CDSR/
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BAIXAR imagens do landsat 8 OLI/TIRS C 1 level -1 do site do https://earthexplorer.usgs.gov para 
isso é necessario um cadastro no site, assim como em outros já citados; 
 

 
 

 
 

https://earthexplorer.usgs.gov/
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Vamos usar os dados do satelite (landsat 8) bandas espectrais 4,5,6 e 8. Vá na pasta e selecione 
as bandas; 
 

 
 

 
 
Retirar as bordas pretas da imagem em cada  banda ou usar a configuração do programa, indo 
em < customize > Arcmap Options > Raster > Raster Layer > e marcar a opção display 
blacground value; 
Clicar em cada cena e ir em propriedades na aba symbology e marcar a opção ( display 
blacground value) e OK; 
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Pronto sua imagens agora se encontra sem as bordas; 

 
Feito isso agora vamos para a reprojeção das bandas; 
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REPROJEÇÃO DE CENAS 

 
Acesse a aba Arccatalog _Datamanegement _ projectins and transformatins_ Raster_Project 
Raster; 

 
No raster de saída der um nome para a reprojeção, a cena a ser usada será a banda 8 e sempre 
lembrar de não colocar espaço nem acentuação ex: reproj_08.tif e clicar em OK; fazer essa etapa 
para todas as cenas sempre colocando o sistema de coodenadas do local.O nome usado faz 
referência as cenas, pois todas fazem parte da cena 63 adquiridas do satelite e assim serão 
renomeadas para fácil compreensão, assim como a proxima cenas que será 64; 

 OBS: porque temos que fazer a reprojeção? As imagens Landsat-8 são orientadas 
ao norte verdadeiro, sendo necessário reprojetá-las. Isso quer dizer que, em vez de 
receber uma cena Landsat-8 na Projeção/Datum WGS1984 UTM Zone 23 S, você 
vai receber uma cena Landsat-8 na Projeção/Datum Datum WGS1984 UTM Zone 
23 N. http://www.processamentodigital.com.br/2013/06/02/landsat-8-novas-
combinacoes-de-bandas/ 
 

 

 

http://www.processamentodigital.com.br/2013/06/02/landsat-8-novas-combinacoes-de-bandas/
http://www.processamentodigital.com.br/2013/06/02/landsat-8-novas-combinacoes-de-bandas/
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Lembrando-se de retirar as bordas logo após a reprojeção, assim como remover as cenas 
anteriores; 
 

 
 

 

COMPOSIÇÃO DE BANDAS 

É usada para que possamos realçar determinados objetos utilizando as falsas-cores; 

 Abrir o ArcToolbox > Data Management Tools > Raster > Data Processing > 
Composite Bands; 

 

 
 
No raster de saída colocar o nome RGB_63 e a extensão .tif e coloque as bandas indicadas e 
clique em OK; 
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Os dados que não forem mais usando podem ser excluídos, no caso as reprojeções podem ser 
apagadas do projeto assim como podem ser inserida se desejar; 
 

 
 

Marque a opção (display background value); 
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FUSIONAMENTO 

 Fusão: É fusionar a banda PAN (tons de Cinza) de 15 metros de resolução espacial com 
outras bandas MULTIESPECTRAIS (coloridas) de 30 metros, para que a resolução 
espacial final da cena Landsat-8 seja de 15 metros, ou seja, proporcionar uma melhor 
resolução da imagem com uma resolução geometrica melhor; 

Data Management Tools > Raster > raster processing > Create Pan-Sharpened Raster Dataset; 
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Cololcar o dado RGB_63 na entrada e em output o nome PAN_63.tif e colocar banda 8 em 
pancromatic image OK; 
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Pronto, sua imagem agora apresenta uma resolução espacial de 15m; 
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OBS: Cuidado, sempre salve seu projeto, aqui ainda não havia sido salvo porque o que nos 
interessa é o fusiomamento, contudo pode ocorrer erro; 
E agora??? Simples!!! Só fazer novamente, contudo você não perdeu seus dados, pois estão 
salvos nas pastas, apenas colocá-los novamente no programa; 
 
Os outros dados podem ser removidas, permanecendo apenas o PANC_63 

 
 

Agora sim!! Salve o seu projeto na pasta MXD e agora faça o mesmo processo para a cena 64 do 
landsat 8, pois acabamos de fazer com a cena 63, use as bandas 4,5,6 e 8; 
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Abra um novo projeto e começe pela reprojeção > composição e fusiomamento. Logo após fazer 
todas as etapas com a banda 64, vamos agora para a união de cenas; 
 
 

 

UNIÃO DE CENAS 

Abra um novo projeto e adicione as cenas RGB_63 e 64 da pasta de composição; 

 
Retire as bordas extras, salve o projeto, vá em <Data Management Tolls > Raster > Raster 
Dataset > mosaic To New Raster > para que a imagem seja apenas uma unidade; 
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No raster de saida apenas clique na pasta mosaico não precisa abrir; 
 

 
 
Insira os dois arquivos e coloque o nome em <raster dataset > coloque o local ( mosaico) e a 
extensão ( .tif), o sistema de coordenadas e em <Pixel time> use a 16 bits unsigned e as demais 
configurações abaixo e OK; 
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Retirar as bordas e insira um limite_municipal; 
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Aqui foi apenas colocada uma borda diferente no limite_municipal para uma melhor visualização; 

 
 
A seguir, vamos extrair das cenas só a parte do limite_municipal de Teresina, para isso vá no 
comando ao lado e clique em <Exctract by Mask>; 
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Selecione a extensão arquivo que irá conter a extração e o local para salvar o projeto; 

 
 
Desligue os demais dados que não são necessarios, salvar Teresina.mxd; 
 
 
CRIANDO SHAPEFILE 

Abrir ArcCatalog conecte a pasta (projeto geoprocessamento); na pasta clique em dados vetoriais 
e em seguida a opção shapefile e em Teresina, este será o local onde ficará armazenado os 
novos shapfiles. Clique com o botão direito do mouse em cima da Teresina e vá na opção de < 
New> e na proxima aba < Shapfile >; 
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Criar shapfile para rio com o uso de polilyne, e a sede_municipal com o ponto e a zona_urbana o 
polígono; 
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A escala vai ser colocada de acordo com a imagem adqurirda, pois elas apresetam propriedades 
que devem ser aplicadas no projeto. 
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GEOPROCESSAMENTO APLICADO À ANÁLISE GEOGRÁFICA COM O QGIS 
 
ABRIR NOVO PROJETO 
Organizar a plataforma do QGIS com os arquivos contendo os dados em uma pasta do 
computador (Local C) de forma bem organizada para que a inserção seja de facil compreensão; 
Ao abrir o QGIS e iniciar um novo projeto, vá a <barra de menus>, na parte superior da interface, 
e selecione a opção <projeto>, em seguida selecione a opção <novo>; 

 

 
CONFIGURAÇÃO DO PROGRAMA 
Ao iniciar um novo projeto, é preciso definir o Sistema de Referência de Coordenadas (SRC) do 
projeto, na qual sua área de estudo está inserida. Para selecionar o sistema de referência, 
direcione à <barra de menus>, selecione a opção <projeto>, a seguir selecione a opção 
<propriedades>, e na janela <Sistema de referência de coordenadas do ‘world’> selecione o 
sistema de referência da sua área de estudo. 
 

 
 



  

RIBEIRO et al., Técnicas de geoprocessamento com os programas ArcGIS e QGIS. Produção Técnica. 
GEOAMBIENTE/UFPI: Teresina, 2020.  25 

 
 
CRIANDO SHAPEFILE 
Para criar um novo shapefile, direcione o mouse na <barra de menus>, em seguida clique na 
opção <camada>, clique na opção <criar nova camada>, e depois clique na opção <vetorial>; 
 

 
Na janela <NOVA CAMADA SHAPEFILE>, escolha o tipo de shapefile que deseja ser criado, 
selecionado um dos tipos: <ponto, linha, polígono>, depois seleccione o <sistema de 
referências de coordenadas>, em seguida preencha os dados para tebela de atributos do 
shapefile; 
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INSERINDO CAMADAS 

Para inserir camadas já existentes na sua base de dados do seu computador, clique no menu 

<camada>, <adicionar camada>, escolha o tipo de camada deseja inserir; 

 

 

Em seguida vai abir o <Gerenciador de Fonte de Dados>, direcione até a janela <fonte>, 

clicando na caixa com 3 pontinhos (...), irá abrir as pastas onde as camadas estão guardadas. 
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ROTULAR CAMADA 

Para rotular uma camada, é necessário que a camada esteja selecionada. Com o botão direito do 

mouse clique na camada e selecione a opção <propriedades>; 
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Ao abrir a janela <Propriedade da camada>, direcione o mouse à coluna lateral esquerda na 

opção <Rótulos>, em seguinda clique na janela suspensa com o nome <Não rotular> e 

selecione a opção <Rótulos simples>; 

 

Após selecionar a opção de <Rótulos simples>, siga até a opção <valor>, e selecione o tipo de 

rótulo que deseja ser mostrado na camada, em seguinda clique em <OK>; 

 
 
 
 
 
 



  

RIBEIRO et al., Técnicas de geoprocessamento com os programas ArcGIS e QGIS. Produção Técnica. 
GEOAMBIENTE/UFPI: Teresina, 2020.  29 

 

VETORIZAÇÃO 

Clica no botão <adicionar camada vetorial>, procure e insira o shape a ser vetorizado no 

projeto; clica em <alternar edição>; para finalizar a edição, clicar com o botão direito do mouse, 

preenche o campo que aparece em tela e na sequência, clica em OK e salvar; 

 
 
 
CRIANDO CAMADAS SHAPEFILE 

Vá no menu <camada>; <criar nova camada>; <shapefile>; escolha o tipo de feição 

(ponto/linha/polígono), indique as coordenadas, nome e local onde será salva e clica em OK; 
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INSERIR TABELAS COM PONTOS 

Vá no menu <Layer>; Add Layer>; <Add Delimited Text Layer>; <file name>, escolha o format do 

arquivo;  Clique OK. Para finalizar, clique com o botão direito sobre o layer, save as e salve o shp; 

 
 

 
MOSAICO 

Adicione as camadas a ser mosaicadas; clica no menu <raster>; opção <miscelânea>; escolher 

<mosaico>;  Escolher a pasta de entrada, o arquivo de saída e clicar em <OK>; 
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MODO DE IMPRESSÃO 

No menu <projeto>, opção <no gerenciador de impressão>; 
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Na aba <Composição> é possível configurar as dimensões do papel e a qualidade de impressão; 
 

 
 
Clique no botão <Adicionar novo mapa>; 
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Faça as configurações para o seu mapa; 
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